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Contact Information 

 

Metrix Support  

Web Site: communities.epssw.com 

US Phone: (412)-785-1699  

UK Phone +44 (1246) 927830  

E-Mail: metrix.support@epssw.com  

 

Metrix Support hours are 8AM CET to 5pm ET Monday – Friday. You may contact support at the above 
numbers or via our customer portal at communities.epssw.com. 

Note For problems involving infrastructure (for example, computers, networks, operating systems, 
backup software, printers, third-party software, etc.), contact the appropriate vendor. Graphic 
Communications cannot support these types of issues. 

 

Professional Services  

E-Mail: myepsservices@epssw.com 

Note Professional Services can help you perform Graphic Communications software installations, 
upgrades, and updates. This group can also help you implement, customize, and optimize 
your Graphic Communications software and offer a range of training options. 

 

  

https://communities.epssw.com/
mailto:metrix.support@epssw.com
https://communities.epssw.com/
mailto:myepsservices@epssw.com
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Metrix Base – Key Features 

• Maximum sheet dimension (W and H): 984.25” (25,000mm). 

• Maximum products handled by Auto Layout: 16. 

• Maximum products per project: 100. 

Feature Included or optional 

Plans/imposes flat, folded, bound, and die-cut jobs Included 

Automatically determines the most cost-effective Production 
Method, Press, and Sheet Size (Auto Production) 

Included 

Automatically matches new layouts to saved profiles 
(Standards) 

Included 

User Permissions, Logins, and Passwords Included 

Handles chop cuts automatically (Auto Bleed) Included 

Prints reports Included 

Imports JDF Included 

Imports Metrix XML and CSV data Included 

Exports Imposed PDF  Included 

Exports Metrix XML Included 

Exports JDF Imposition/JDF Stripping Included 

Exports JDF/CIP 3 Cutting data Included 

Exports JDF/CIP Folding data Included 

Exports JDF Binding data Included 

Site Licenses Included 

JDF Color Mapping Included 

Roll-fed presses Included 

Stock support Included 

Run List Included 

Auto Expand/Contract Trims Included 

Super Wide Format  Included 

Media Optimization module Included 

Display Graphics module Included 

Content Previews Included 

Barcodes module Included 

Cut and Stack module Included 

Multi-Web Support Included 

Auto Plan module Optional 

Capacity Plus module Optional 

N-Up Binding module Optional 

Automation Pro module Optional 

Automation Lite module Optional 

Irregular Shapes module Optional 
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Optional Modules 

Auto Plan Module 

• Automatically and dynamically determines how many layouts are required for the products in the 
project. 

• Plans and simultaneously imposes across multiple press sheets and even multiple presses. 

• Uses real costing data from the Metrix database. 

• Applies standards where appropriate. 

• Uses proprietary and sophisticated algorithms to consider dozens, hundreds, or even thousands of 
options to find the most cost-effective project solution. 

 

Capacity Plus Module 

• Allows for projects of greater complexity – more products for Auto Layout and Auto Production 
calculations and more products per project. 

• Up to 2,000 products allowed per project, regardless of the number of press sheets. 

• Up to 200 products allowed for Auto Production and Auto Layout calculations. 

 

N-Up Binding Module 

• Automates setup of products that print, fold, and bind 2- or 3-up on a press sheet. 

• Provides visual feedback on how the project will fit on a press sheet with the new manufacturing 
configuration. 

Note: Metrix compensates for shingling/creep. 

 

Automation Pro / Automation Lite Modules 

Automation Pro and Automation Lite are advanced hot-folder-driven modules for Metrix that accept 
MXML, CSV, JDF Stripping, or JDF Intent files and fully automate their processing in Metrix. “Automation 
mode” (available in the File menu) switches Metrix to the Automation User Interface that enables many 
projects to flow through Metrix with no operator involvement. 

• When MXML files arrive in the Automation Hot Folder, the system: 

▪ Creates a Metrix project. 

▪ Applies settings. 

▪ Performs tasks. 

▪ Exports output files (JDF, PDF, etc.) automatically. 

• Commands can come from two places:  

▪ Loaded from one of several Commands files. 
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▪ Embedded in the incoming MXML data (Pro only). 

 

Automation Lite functions like Automation Pro with two differences:  

• Automation Lite does not allow you to embed scripting commands in incoming MXML files. 

• There is no requirement to maintain a Maintenance Service Agreement (MSA). 

 

Non-rectangular Shapes Module 

• Ability to nest non-rectangular shapes without needing a die-cutting tool or multi-up die standard.  

• Die-cutting tools and multi-up die standards use the geometry of customer-supplied multi-up dies. 

• Plans projects that contain a mix of die-cut and other types of products. 

Note: Metrix plans die-cut products to a separate layout from other types of products. 

  



Platform and Licensing | Installation Guide ⚫ 9 

 

 

Platform and Licensing 

Metrix features and functionality are identical on Windows and Mac OS. You can mix and match in a 
multi-user environment. eFlow licensing works on either platform. 

 

License Types 

Metrix 25.1 uses eFlow License Manager, a web-based license server that replaces dongle-based 
licensing. The two license types are:  

• Concurrent User License: This replaces the Network License, which allowed multiple installations 
of Metrix to use the same License Server and dongle. The Concurrent User License is managed by 
eFlow and can be shared by multiple users who can also share the same database via the Database 
Server. 

• Single User License: This replaces the Local Machine License, which applies to only one 
installation of Metrix. The Single User License is also managed by eFlow. It can be used by only one 
installation of Metrix at a time and requires using an embedded database. 

 

Metrix Multi-User Deployment 

Multiple instances of Metrix on Windows and/or Mac OS can share a single eFlow license key via the 
eFlow License Manager, which serves the license to Metrix clients on the network. 

This installation is called Concurrent User Licensed Metrix. The Metrix Data Server can be either on the 
same computer as the eFlow License Manager or on a different one. 

Note: Metrix clients are full installations of the software, where the processing occurs locally, that share 
data through the Metrix Data Server. 

 

eFlow License Manager 

Important: Metrix 25.1 requires eFlow LIM version 10.0.10056.39 or newer. This version is compatible 
with Mac OS 12 and Windows 11. At the time of this release, the latest version of eFlow LIM is 
12.0.120027.15. You can download the eFlow LIM installer for Windows and Mac using the following 
links: 

eFlow_12.3.123045.33_MacOS_LIM.zip  (Mac installer) 

eFlow_12.3.123045.33_Win_LIM.exe  (Windows installer) 

 

About the eFlow License Manager  

eFlow License Manager (LIM) is used for licensing Graphic Communications components. This is for 
components that do not need the full capabilities of the main eFlow product.    

After you install the eFlow LIM, you can then apply the license for your Graphic Communications 
component using a license key. The installation and licensing process requires an Internet connection.  

Notes: 

 If do not have an Internet connection on the machine where you are applying the license, you can 
request a license file from Graphic Communications.   

https://tinyurl.com/yewwym8z
https://tinyurl.com/3bueh864
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 If you need to transfer the license to a separate machine after it has already been applied, contact 
Support.   
 

 If you need to transfer the eFlow LIM to another server, contact Support as you will not be able to 
reactivate the license for Metrix using the same activation code.    

 

Licensing Metrix  

Only Metrix can be licensed using the eFlow LIM.   

The eFlow LIM permits you to install Metrix on any number of computers because the License Server 
controls the number of concurrent users running Metrix at any one time. 

Metrix uses three main programs when running this way: 

• eFlow License Manager: The program that controls the number of Metrix clients that can run at any 

one time. eFlow LIM requires a license key to run and must have a static IP address. 

• Metrix Data Server: Metrix clients communicate with this program to access the database. The Data 

Server must have a static IP address so the Metrix clients can access the shared database. 

• Metrix: The full install of Metrix on any number of computers within a single physical site that have 

network access to the eFlow License Server and the Metrix Data Server. Metrix client installations 
must also have the eFlow License Key to run. 

Note: You can install eFlow LIM on the same machine as the Metrix Automation Server.  

 

About Services  

When eFlow LIM is installed, the eFlow Service is installed. This service must be left running for your 
license to be active and validated.    

You can verify that the service is running in the eFlow Control Panel: 

 

 

Install the eFlow License Manager 

You must install and run the eFlow License Manager prior to starting Metrix.  
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Windows Installation 

1. Close all open programs. 

2. Click the execute the eFlow 12.3.123045.33 file to launch the installer. 

3. If the User Account Control window appears, click Yes to continue. 

4. Click the I agree radio button to accept the license agreement, and then click Next.  

 

 

5. Accept the default location of C:\eflow, or select a different location, and then click Next.  

 

 

6. Click Install in the Pre-Installation Summary window.  
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7. When the installation is complete, click Done to exit the installer.  

 

 

Windows Upgrade 

1. Close all open programs. 

2. Close the Control Panel but do not stop the eFlow service. 

3. Click the eFlow_12.3.123045.33_Win_LIM.exe file to launch the installer. 

4. If the User Account Control window appears, click Yes to continue. 

5. Click the I accept the terms of the License Agreement radio button to accept the license 
agreement, and then click Next. 
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6. Accept the default location of C:\eflow, or select a different location, and then click Next.  

 

 

If the eFlow LIM control panel is open, the “LIM is still running” window will prompt you to close the 
program.  

7. Click Install in the Pre-Installation Summary window.  
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8. When the upgrade is complete, click Done in the Upgrade Complete window and restart your 
computer. 
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Mac OS Installation 

MacOS 14 or 15  

If you are installing eFlow LIM on MacOS 14 (Sonoma), or OS 15 (Sequoia) complete the following 
before continuing:  

1. Download the eFlow LIM Mac installer from eFlow_12.3.123045.33_MacOS_LIM.zip.  

2. If the eFlow LIM installer does not automatically unzip, unzip the downloaded zip file and copy the 
‘eFlow LIM Installer’ to the Applications folder directly. 

3. Execute the eFlow LIM Installer app. Since the application is downloaded from the Internet and has 
not been notarized (signed) by Apple it has a 'com.apple.quarantine' attribute. This attribute can be 
removed by either of two ways: 

a. Approach 1 - Using UI: 

Go to the Applications folder, double click (or CMD+Click Open) on eFlow LIM Installer. Click 
Done on the warning pop-up “Apple could not verify…“: 

 

 

Go to System Security>Privacy and Security, and select Open Anyway for warning “eFlow 

LIM Installer was blocked to protect your Mac". Provide your admin password and follow the 
instructions (if it doesn’t open, try the second approach). 

 

 

 

 

 

 

 

b. Approach 2 - Using Terminal: 
Open terminal and run the following command, providing the admin password (modify the app 
name as per installer name in your Application folder): 
sudo xattr -rd com.apple.quarantine /Applications/eFlow\ LIM\ Installer.app 
 

Double-click the app and follow the instructions. eFlow LIM might take a while to launch the 
JVM, please be patient and wait for a while. Please contact eFlow Support if you require help. 

https://tinyurl.com/yewwym8z
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MacOS 26 or later  

If you are installing eFlow LIM on MacOS 26.0 (Tahoe) onwards: 

Starting with macOS Tahoe 26.0, Apple has tightened System Integrity Protection (SIP) by enforcing 
stricter policies around inter-application scripting. Direct control of one application by another (e.g., via 
AppleScript or automation) now requires explicit user consent. For eFlow LIM, access to the Finder 
process is required.  
 
After following all the above steps under “Step-by-Step Installation Guide“, macOS 26.0 requests 
permission for Finder through a system prompt. User must select Allow when requested:  

 

 

If the consent dialog is not presented, use any one of the following methods: 

1. Open System Settings >Privacy & Security >Automation and enable Finder access for eFlow 
LIM. 

 

 

2. Reset the AppleEvents permission database for eFlow Installer via Terminal by running below 
command. On the next invocation, macOS will re-prompt for Finder access: 

tccutil reset AppleEvents com.apple.ScriptEditor.id.eFlow-LIM-Installer 

Mac OS Upgrade 

1. Stop the eFlow service and close the eFlow LIM Control Panel. 

2. Download the eFlow LIM installer as described above. 

3. If you are installing eFlow LIM on MacOS 14 (Sonoma), then do the following before continuing to 
step 4. 

a. Download the eFlow LIM Mac installer from eFlow_12.3.123045.33_MacOS_LIM.zip.  

https://tinyurl.com/yewwym8z
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b. If the eFlow LIM installer does not automatically unzip, then unzip the eFlow LIM installer while it 
is still in the Downloads folder.  

c. Copy the installer file and navigate to Go > Computer > Macintosh HD > Users. Create a new 
folder called EFlowInstaller and paste the installer file inside this folder. 

d. Open System Preferences and click Security & Privacy. Go to the Full Disk Access tab, 
then click the + (plus) icon and add the eFlow installer file ("eFlow LIM") to grant it full disk 
access. 

4. Double-click the EFI eFlow LIM.app file to launch the installer. 

5. If the EFI eFlowLIM can’t be opened a message appears, click Cancel. 

 

 

6. Next, right-click on the EFI eFlow LIM.app file and select Open to launch the installer.  

7. Click Open in the “macOS cannot verify the developer of “EFI eFlow LIM.app”” message 
window.  
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8. Enter your Password, and then click OK. 

 

 

9. Launch the eFlow LIM Control Panel.  

10. If the service does not start automatically, click Start to start the eFlow service. 
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Windows and MacOS Initial Setup 

1. Click the eFlow icon to launch eFlow License Manager Control Panel. 

2. Enter the License Key, or eFlow License Key, and your Contact Email address into the appropriate 
fields.  

Metrix Support will send your Contact Email address a notification that includes your License Key, 
or eFlow License Key.  

 

 

3. In the Region Detector window, select Yes if you are in a non-European region, and select No if you are in a 
European region. 

 

If you select No, the Select an Option window will appear. Click Yes to confirm you are installing 
eFlow in a European region. 

 

 

4. Verify your License Status and select Show License to open the License Information window. 
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5. Click the Customer folder and copy your Customer ID number. After you install Metrix, you will 
need your Customer ID number to complete the Metrix Initial Setup as described in the section 
Launch Metrix. 
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Installing Metrix 

Upgrading old versions of Metrix 

Metrix 25.1 is a full install only – there is no updater. To upgrade, you need to uninstall the previous 
version of Metrix and then perform a complete reinstallation. For instructions on uninstalling a previous 
version, please see Upgrading Metrix backup of your database before upgrading Metrix.  

If you are upgrading from Metrix 2018 or earlier with all database types, you must install Metrix 2019.2 
and upgrade the database to that version before installing Metrix 24.1 and upgrading the database again.  

If you are running Metrix with a HSQL database (Metrix Database Server or embedded database) and are 
upgrading from Metrix 2019.2 or later, you may see a message that tells you the database must be 
upgraded or that Metrix cannot find the database. In that case, you must first install Metrix 22.2 and 
upgrade the database to that version before installing Metrix 24.1.   

 

Windows installation 

Minimum system requirements on Windows 

• Processor: Intel compatible, recommended: 8-core and 16-thread, minimum 4-core and 8-thread 
processor. Media Optimization module requires a minimum 8-core CPU (recommended 16 core if 
the Super Wide module is used: 

▪ Processor Speed: 2.8 GHz minimum 

▪ Operating Systems: 

 Metrix 25.1 will install only on 64-bit systems. Supported operating system versions 
include: 

 Microsoft Windows 11.x (64-bit) 

 Microsoft Windows Server 2019 (64-bit) 

 Microsoft Windows Server 2016 (64-bit) 

 Microsoft Windows Server 2022 (64-bit) 

 Microsoft Windows Server 2025 (64-bit) 

 Microsoft SQL Server 2014 SP3 and SP4 (64-bit) 

 Microsoft SQL Server 2016, 2017, 2019, 2022 and 2025 

Microsoft has ended support for Windows 10, so Metrix will no longer support that platform. 
Microsoft has announced they will end support for Windows Server 2012 R2 effective October 
10, 2023; Metrix will no longer support that platform after that date. We recommend you 
upgrade your system to Metrix current minimum system requirements. 

▪ Memory: Metrix installs with Memory requirements set to 4 GB for Metrix client and Data 
Server. If you need to change this, you can reduce it to 2 GB. For instructions on how to do this, 
please contact Metrix Support. 

 Metrix client—4 GB RAM 

 Metrix Data Server—2 GB RAM 

 Metrix Automation Server—8 GB  
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 Automation Server Pro – 16 GB RAM (Minimum) to 4 GB RAM per CPU Core (64 GB RAM 
Maximum) 

 Automation Server Enterprise – 64 GB RAM (Minimum) to 4 GB RAM per CPU Core (256 
GB RAM Maximum) 

 Automation Server with Non-Rectangular module—8 GB RAM (Minimum) and 1 Dual-core 
Processor (Minimum) 

 Automation Server with Display Graphics/Media Optimization/Super Wide Format—16 GB 
RAM (Minimum) (32 GB RAM and 16-core, 32-thread processor or better recommended) 

 eFlow License Manager – 256 MB RAM 

▪ Monitor Resolution: 1280 x 1024 or higher 

▪ Network (multi-user): Static IP address for the Data Server, eFlow License Manager, and 
Automation Server. Automation Server runs as a service and needs a local administration 
account. Please note: 

 If you use the Content Previews module, the minimum RAM requirement for Metrix is 6 GB 
with 8 GB or more recommended. 

 The Content Previews module is processor intensive, so a fast multi-core processor is 
recommended. If PDF content is being accessed across a LAN, gigabit network speeds are 
recommended when accessing large content files. 

 

Pre-installation checklists 

Upgrading to Metrix 25.1 from a previous version 

Be sure to save a backup of your Metrix Data and Marks folders, metrix.properties file, and Metrix 
Password file (.mpw, needed only if you are upgrading from Metrix 2016.2 or earlier) so that you can 
revert to your previous version if necessary. 

Important: 

 Always make a backup of your database before upgrading Metrix.  

 If you are upgrading from Metrix 2018 or earlier with all database types, you must install Metrix 2019.2 
and upgrade the database to that version before installing Metrix 24.1 and upgrading the database 
again.  

 If you are running Metrix with a HSQL database (Metrix Database Server or embedded database) and 
are upgrading from Metrix 2019.2 or later, you may see a message that tells you the database must be 
upgraded or that Metrix cannot find the database. In that case, you must first install Metrix 22.2 and 
upgrade the database to that version before installing Metrix 25.1. 

 

Metrix for Windows – Single User License 

Before you begin installing Metrix make sure that: 

• Your Windows computer meets the minimum system requirements. 

• You have your eFlow License Key available (Metrix needs this key to run). 

Metrix for Windows – Concurrent User License 

Before you begin installing Metrix make sure that: 
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• Your Windows computer meets the minimum system requirements. 

• The ports required for Metrix to communicate are open (see below). 

• A static IP address is assigned to the computer(s) on which the eFlow License Manager and Data 
Server reside. 

• You have your eFlow License Key available (Metrix needs this key to run). 

 

Windows communication ports 

For any multi-user installation of Metrix, the following ports must be open: 

• Data Server: 9939 

• eFlow License Manager: 8081 

• SQL Server: 1433 

• PostgreSQL Server: 5432 

 

Installing Metrix on the Windows platform 

You must have Administrator privileges to install Metrix. Before installing, close all applications and restart 
your computer to clear any files from memory. 

1. Copy the ePS Metrix Installer.exe file to your computer. Exact file names will vary based on the 
build number. For example, ePS Metrix 20251XXXXX.exe. 

2. Double-click ePS Metrix Installer. 

3. If the installer requests permission to install Metrix on your computer, click Yes to begin the 
installation. 

4. On the welcome screen, click Next. 
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5. On the License Agreement screen, read the “Software End User License Agreement,” click I 
accept the terms of the license agreement, and then click Next.  Click Print if you want to print a 
copy of the EULA for your records. 

 

 

6. In the Setup Type screen, select the default Complete (unless you have a reason to choose 
Custom), and then click Next.  

 

 

7. On the Ready to Install the Program screen, click Install. 
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The Installing ePS Metrix screen will show progress as the software is installed. If a screen appears 
asking, Do you want to allow this app from an unknown publisher to make changes to your 
device, click Yes. 

 

 

8. On the InstallShield Wizard Completed screen, click Finish. 
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Mac OS installation 

Minimum system requirements 

• Processor: Intel Core 2 Duo, recommended: 8-core and 16-thread processor. The Media 
Optimization module requires a minimum 8 core CPU (recommended 16 core if the Super Wide 
module is used.) 

• Processor Speed: 2.8 GHz minimum 

• Operating System: 

▪ OS 26 (Tahoe)  

▪ OS 15 (Sequoia) 

▪ OS 14 (Sonoma) 

• Memory: Metrix installs with memory requirements set to 4 GB for Metrix client and Data Server. If 
you need to change this, you can reduce it to 2 GB. For instructions on how to do this, contact Metrix 
Support (see page 5 for contact information).:  

▪ Metrix Client – 4 GB RAM 

▪ Metrix Data Server – 2 GB RAM 

▪ eFlow License Manager – 256 MB RAM  

▪ Media Optimization – 16 GB RAM  

If you use the Content Previews module, the minimum RAM requirement for Metrix is 6 GB with 8 
GB or more recommended. 

The Content Previews module is processor intensive. Thus, we recommend a fast multi-core 
processor. If PDF content is being accessed across a LAN, gigabit network speeds are 
recommended when accessing large content files 

• Monitor Resolution: 1280 x 1024 or higher 



Installing Metrix | Installation Guide ⚫ 27 

 

 

• Network (multi-user): Static IP address for the Data Server and eFlow License Manager. 

If you use the Content Previews module, the minimum RAM requirement for Metrix is 6 GB with 8 
GB or more recommended. 

The Content Previews module is processor intensive. Thus, we recommend a fast multi-core 
processor. If PDF content is being accessed across a LAN, gigabit network speeds are 
recommended when accessing large content files. 

 

Pre-installation checklist 

Upgrading to Metrix from a previous version  

To upgrade, you need to uninstall the previous version of Metrix and then perform a complete reinstall. 
After completing the steps in this section, you will be directed to go to Installing Metrix.  

Be sure to read the instructions from the beginning and save a backup of your Metrix Data and Marks 
folders, metrix.properties file, and Metrix password file (.mpw, needed only if you are upgrading from 
Metrix 2016.2 or earlier) so that you can revert to your previous version if necessary: 

• Always take a backup of your database before upgrading Metrix.  

• If you are upgrading from Metrix 2018 or earlier with all database types, you must install Metrix 
2019.2 and upgrade the database to that version before installing Metrix 25.1 and upgrading the 
database again.  

• If you are running Metrix with a HSQL database (Metrix Database Server or embedded database) 
and are upgrading from Metrix 2019.2 or later, you may see a message that tells you the database 
must be upgraded or that Metrix cannot find the database. In that case, you must first install Metrix 
22.2 and upgrade the database to that version before installing Metrix 25.1. 

Metrix for MacOS  – Single User License 

Before you begin installing Metrix make sure that: 

• Your Mac OS X computer meets the minimum system requirements. 

• You have your eFlow License Key available (Metrix needs this key to run). 

 

Metrix for MacOS  – Concurrent User License 

Before you begin installing Metrix make sure: 

• Your MacOS X computer meets the minimum system requirements. 

• The ports required for Metrix to communicate are open (see below). 

• Static IP addresses have been assigned to the Data Server and to the eFlow License Server Control 
Panel. 

• You have your eFlow license key available (Metrix needs this key to run). 

 

Mac OS communication ports 

For any multi-user installation of Metrix, the following ports must be open: 

• Data Server: 9939 
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• eFlow License Manager: 8081 

• SQL Server: 1433 

• PostgreSQL Server: 5432 

 

Installing Metrix on the Mac 

Before installing, we recommend that you close all applications and restart your computer to clear any 
files from memory. You must have Administrator privileges to install Metrix. To start the Metrix Installer: 

• Copy the ePS Metrix Installer.dmg file to the desktop on your computer. Exact file names will vary 
based on the build number. For example, ePS Metrix 20251XXXX.dmg. 

• Double-click the ePS Metrix Installer file to open the ePS Metrix Installer disk image. 

• On the ePS Metrix Installer screen, double-click the ePS Metrix Installer.app to start the Installer. 

 

 

1. If an alert screen opens, click Open to continue. 

 

 

2. On the next screen:  
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▪ Click the Terms Of Service link and read the License Agreement. Click the Back button to 
return to this screen. 

▪ If you agree to the terms of the License Agreement, select the I agree to the Terms Of 
Service check box. 

 

 

3. Drag the application to the disk to complete the installation:  

 

 

 

4. On the authentication screen, enter the username and password for your system, and then click OK. 
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5. When the installation is complete, click Close. 

 

 

To set up Metrix, go to Launch Metrix and Initial Setup. 

 

Installing New Renderer on Mac OS 

Metrix will use the new preview renderer, which provides overprint previews for content containing 
overprint layers. 

GhostScript is not installed as part of the Metrix installation on a Mac OS system. The instructions to 
install GhostScript on a Mac OS are as follows: 

1. Check if the Metrix Package is installed on your system. Navigate to Applications > EPS > Metrix. 
If the Metrix folder is present inside the EPS folder, it indicates that Metrix is installed. If not, install 
Metrix on your system first. 

2. Locate the InstallGhostScript.sh file inside the Metrix folder. The Metrix folder structure will be like 
shown below: 
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3. Open Terminal and enter cd /Applications/EPS/ Metrix. Then execute the script file by entering 
./InstallGhostScript.sh and press Enter.  

 

 

Terminal may prompt you to enter your system password and press the Enter key a couple of times. 
Once done, it will automatically install HomeBrew and GhostScript on your system if they are not 
already installed (a strong internet connection is required). After successful installation, a 
confirmation message in Terminal is displayed. 
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4. To verify whether Homebrew and GhostScript are installed, navigate to Go > Go to folder and enter 
/opt/ in the search field.   

 

 

5. You should find the Homebrew folder inside the opt folder, confirming that Homebrew has been 
successfully installed. 
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6. To verify GhostScript installation, navigate to homebrew>Cellar folder. You will find the 
ghostscript folder inside Cellar if GhostScript is installed correctly. 

 

 

Enabling the New Preview Renderer 

You can display previews with the option to enable/disable the Overprint and Knockout feature:  

1. To toggle the Overprint and Knockout feature in the preview within the Metrix application: 

a. Navigate to Settings>User Preferences. 

b. In the Content Handling tab, set the New Preview Renderer option to True. By default, this 
option is set to False. Click on OK to save the changes. 
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Launch Metrix and Initial Setup 

Earlier versions of Metrix installed in C:\ProgramData\EPS\Metrix and C:\Program Files\EPS\Metrix on 
Windows and /Applications/EPS/Metrix on MacOS; Metrix 22.2 and newer installs in 
C:\ProgramData\ePS\Metrix and C:\Program Files\EPS\Metrix on Windows and /Applications/EPS/Metrix 
on MacOS. If you are upgrading Metrix from an earlier version, make a backup of your Data and Marks 
folders and, after installing Metrix 25.1, place those copied folders in C:\ProgramData\EPS\Metrix 
(Windows) or /Applications/EPS/Metrix (Mac). 

1. Start eFlow License Manager if it is not already running. 

2. If you have Concurrent Licensed Metrix, start the Data Server (C:\ProgramFiles\ePS\Metrix or 
/Applications/EPS/Metrix). 

3. Double-click the Metrix application icon on your desktop. 

4. In the Metrix Initial Setup screen provide the setup information (the image below is from a Mac 
installation).  

▪ On the right of the screen you will see red and green icons: 

 Green = OK  

 Red = Required fields 

▪ Locale: Accept the default English or select another language from the pull-down list. 

▪ MIS System: Accept the default (None) or select an MIS option from the pull-down list. 

▪ License Server Address: Enter the static IP address or DNS name for your eFlow License 
Manager. 

 If you are running the eFlow License Manager on the local machine, enter localhost or 
127.0.0.1. 

 If you are running the eFlow License Manager on a different machine, enter the IP address 
for that server. 

 Press the Tab or Enter key to validate the license server address. 

When the connection is established, eFlow appears in the field next to the License Server 
Address field. 

If the text “Failed to identify licensing type” appears, verify that the eFlow License Manager 
is running, the computer is connected to the network, and you have entered the correct 
license server address and port (if applicable), and then press Tab again. Validation of the 
license server IP address should take no longer than 5 seconds.   

If you choose to change the default port for the eFlow License Manager, enter the IP 
address followed by a colon and the port number (e.g., 192.168.1.10:8082 or eflow:8082). 

▪ Customer ID: Enter the Customer ID number provided by ePS for your Metrix license. 

▪ Measurement Units: Select an option (i.e., Inches or Millimeters). 
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Database Configuration Settings:  

▪ Database: Click on the Database pull-down list and choose from the options:  

 Embedded Database – select this if you have a Single User License. No additional fields 
are required. 

 Metrix Database Server (hypersonic). Enter the Database Server’s static IP address. If you 
selected either Microsoft SQL Server or PostgreSQL Server, enter the DNS name of the 
computer on which the Database Server is installed. 

If you select either Microsoft SQL Server or PostgreSQL Server, the Database Name, 
Username, Password, and Connection Properties fields become available: 

 Microsoft SQL Server. Enter the DNS name of the computer on which the Database Server 
is installed. 

 PostgreSQL Server. Enter the DNS name of the computer on which the Database Server is 
installed. 

Note: If your SQL configuration requires a port for the Database Server other than the default (1433 for 
Microsoft SQL Server, 6543 for PostgreSQL Server with eFlow, 5432 for PostgreSQL Server without 
eFlow, 9939 for Metrix Database Server), in the Database Address field enter the address or DNS 
Name followed by a colon and the port number (e.g., 123.45.6.78:9999). 

 

Important: When you do new setup using the Metrix Initial Setup dialog, "encrypt=true" and 
"trustServerCertificate=true" tags are automatically added in the Connection Properties field while 
connecting to an MS SQL database. 
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For existing databases, you must edit the metrix.properties file to add the flag. Edit the jdbc.URL line. An 
example is below: 
jdbc.URL=jdbc\:sqlserver\://MSSQL.sample.com\:1433;databaseName\=metrix; 
encrypt=true;trustServerCertificate\=true 

 

Important: When you do new setup using the Metrix Initial Setup dialog, "encrypt=true" and 
"trustServerCertificate=true" tags are automatically added in the Connection Properties field while 
connecting to an MS SQL database. 

   

Note: Metrix validates the Database Configuration information when all the relevant fields for the 
selected database type have been completed. 

If a message appears at the top of the screen informing you that Metrix cannot find the database server, 
verify that the server is running, the computer is connected to the network, and you have entered the 
correct database server address and port (if applicable). Click the Database Address field, and then 
press Tab again. Validation of the database server IP address should take no longer than 5 seconds. 

 

Click Save and Launch to open Metrix (or click Quit to close without saving), log into Metrix with the 

password that applies to your User Role, and then click OK: 

Login Password 

Administrator a 

Guest guest 

Senior senior 

Junior junior 

 

Important: Change your password to a more secure alternative when you are finished, or create  your 
own user IDs and passwords in the database. 
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Upgrading Metrix 

To upgrade, you need to uninstall the previous version of Metrix and then perform a complete reinstall. 
After completing the steps in this section, go to Installing Metrix.  

If you are running Metrix with a HSQL database (Metrix Database Server or embedded database) and are 
upgrading from Metrix 2019.2 or later, you must first back up your database, install Metrix 22.2, and 
upgrade the database to that version before installing Metrix 25.1. 

If you are upgrading from Metrix 2018 or earlier, you must back up your database, install Metrix 2019.2, 
and then upgrade the database to 2019.2. You must then install Metrix 22.2 and upgrade the database to 
that version before installing Metrix 25.1 and upgrading the database again.  

 

Note: “ePS Metrix” is in the process of being rebranded to CAI Graphic Communications.  rebranded as 
“ePS Metrix”. As a result, the directory structure has changed. Metrix 22.1 and earlier was installed into 
C:\Program Files\EFI\ and C:\ProgramData\EFI\ on Windows, and in /Applications/EFI/ on Mac. Metrix 
22.2 installs into C:\Program Files\EPS and C:\ProgramData\EPS\ on Windows and into 
/Applications/EPS/ on Mac. 

 

 (1) Shut Down the Data Server and the License Server 

Shutting down the Data Server 

Ensure that all Metrix clients are shut down: 

• Metrix 2016.2 and earlier: On the Data Server computer, execute Shutdown Metrix Data Server. 

• Metrix 2017.3 and later: In the Metrix Data Server window, click Shutdown.    

Important: These are the only methods you should use to shut down the Data Server. If the Data 
Server is ever shut down abruptly (for example, with a CTRL+C in a command line in Windows or Force 
Quit on Mac), some data loss may occur. 

 

 (2) Back up your Metrix 22.2 (and earlier) files and folders 

To preserve the Metrix database, marks, and settings, back up these Metrix folders and files found inside 
your Metrix folder, C:\ProgramData\EPS\. An easy way to do this is to make a copy on your desktop of 
these folders. 

• Data folder 

• Marks folder 

• metrix.properties file (Metrix 2016.2 and earlier) 

Note: Not all configurations of Metrix have all the above folders and files in the Metrix folder. If your 
Metrix folder does not contain all the above folders and files, then back up the files it does contain. 
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(3) Uninstall Metrix 

Windows 

1. Go to the Windows Control Panel. 

2. Select Uninstall a program and uninstall the Metrix program. Depending on which version of Metrix 
is installed, it may be in the EFI directory or the EPS directory. 

3. Delete the Metrix folder at C:\ProgramData\EPS\. If your ProgramData folder does not appear in 
your C: drive menu, follow the steps to make the ProgramData folder visible: 

a. Click the Windows Start button.  

b. In the Search programs and files field, type “folder options.”  

c. Select the Change search options for files and folders option. 

d. Open the View tab.  

e. In the Files and Folders | Hidden files and folders section, select Show hidden files, folders, 
and drives.  

f. Click Apply. 

g. Click OK. 

4. You should now be able to see the ProgramData folder on your hard drive so you can open it and 
delete the Metrix folder. 

Mac 

1. Go to Applications > EPS on your computer and drag the Metrix folder into the trash. If the Metrix 
shortcuts on your desktop did not disappear, drag them into the trash too. Depending on which 
version of Metrix is installed, it may be in the EFI directory or the EPS directory. 

2. Empty the trash. 
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Installing Metrix Automation Server (AS)  

Metrix Automation Server runs only on Windows. 

Installing Metrix Automation Server 

Before installing, close all applications and restart your computer to clear any files from memory. 

1. Copy the Metrix_AutomationServer_20251XXX.exe file to your computer. Exact file names will 
vary based on the build number. 

2. Double-click ePS Metrix Installer. 

3. If the installer requests permission to install Metrix on your computer, click Yes to begin the 
installation. 

4. On the welcome screen, click Next. 

 

5. On the License Agreement screen, read the “ePS Software End User License Agreement,” click I 
accept the terms of the license agreement, and then click Next.  

Note: Click Print if you want to print a copy of the EULA for your records. 
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6. In the Setup Type screen, select the default Complete (unless you have a reason to choose 
Custom), and then click Next.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. On the Ready to Install the Program screen, click Install. 
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8. The Setup Status screen shows progress as the software is installed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. On the InstallShield Wizard Complete screen, click Finish. 
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Configuring Metrix Automation Server as a Service 

Metrix Automation Server can be configured to run as a headless service for optimization. This service 
needs to be readily available and resilient, so it is recommended to deploy this application as a Windows 
service. 

1. Follow the standard procedures for installing the Metrix Automation Server.  

2. Run Metrix in GUI mode and configure the application to ensure it is functioning normally.  

3. Close the application.  

4. Press the Windows key and type cmd.  

Note: You can also enter cmd directly into the Windows search bar.  

 

  

 

5. Right-click on Command Prompt and select Run as administrator.  

 

 

6. Execute the following commands one at a time. If this folder does not exist, the installed version of 
Automation Server does not support Windows service and you cannot complete the configuration.   

▪ Command: cd “C:\Program Files\ePS\MetrixAS\Service\bat” 

If this folder does not exist, the installed version of Automation Server does not support 
Windows service and you cannot complete the configuration. 

▪ Command: set JAVA_HOME=“C:\Program Files\ePS\MetrixAS\JREX64” 
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This temporarily sets the JAVA_HOME to Metrix Java.  

▪ Command: setx path “%path%;C:\Program Files\ePS\MetrixAS\JREX64\bin” 

This permanently adds the Metrix Java to the system path.   

7. Install the service: 

▪ Command: installService.bat 

If the command does not execute the install, run setenv.bat and then run installService.bat 
again. Optionally, you can run the command startService.bat. Other commands include 
StopService.bat and UninstallService.bat. 

8. Go to Services in Windows and locate the Metrix Automation Server, or Metrix Automation 
Server Pace.  

9. Right-click and change Automatic to Automatic with delay.  

10. The first time you must start the service manually.  

11. To confirm the service is running go to C:\ProgramData\ePS\MetrixAS\Logs\ and try to delete all 
files. If the system returns the "Unable to delete two files message" which means the service is 
running. 

Note: If your server machine gets restarted, then the Metrix Automation Server service will start 
automatically.  
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Upgrading Metrix Automation Server 

To upgrade, you need to uninstall the previous version of Metrix Automation Server and then perform a 
complete reinstall. After completing the steps in this section, go to Installing Metrix Automation Server.  

(1) Shut Down Metrix Automation Server 

(2) Back up your Metrix Automation Server 21.2 (and earlier) 
metrix.properties file 

To preserve the Metrix Automation Server configuration and licensing settings, back up the 
metrix.properties file, which is in C:\ProgramData\ePS\Metrix. An easy way to do this is to make a copy 
on your desktop. 

(3) Uninstall Metrix Automation Server 

1. Go to the Windows Control Panel. 

2. Select Uninstall a program and uninstall the Metrix Automation Server program. Depending on 
which version of Metrix is installed, it may be in the EFI directory or the EPS directory. 

3. Delete the Metrix folder at C:\ProgramData\ePS\. If your ProgramData folder does not appear in 
your C: drive menu, follow the steps to make the ProgramData folder visible: 

a. Click the Windows Start button. In the Search programs and files field, type “folder options.” 

b. Select the Change search options for files and folders option. 

c. Open the View tab.  

d. In the Files and Folders | Hidden files and folders section, select Show hidden files, 
folders, and drives.  

e. Click Apply. 

f. Click OK. 

4. You should now be able to see the ProgramData folder on your hard drive so you can open it and 
delete the Metrix folder. 

(4) Install Metrix Automation Server 

Go to Installing Metrix Automation Server and follow the instructions. When the installation is complete, 
place the backup copy of the metrix.properties file in C:\ProgramData\ePS\MetrixAS and then launch 
Metrix Automation Server. 

and may be changed to user-specified locations):  
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Appendix A: Where Metrix Files Are Installed in Windows 

Metrix for Windows has been engineered to run properly for a non-administrator user without requiring 
Run as Administrator privileges. Windows Metrix 25.1 looks for files in the ProgramData/ePS folder. 

The initial configuration of the following folders and file will be in the ProgramData/ePS folder (although 
some are user configurable and may be changed to user-specified locations):  

 

• Automation 

• Commands 

• Content 

• Data 

• PreviewCache  

• PreferencesBackup 

• Imports 

• Logs 

• metrix.properties file 

 

If your ProgramData folder does not appear in your C: drive menu: 

1. Click the Windows Start button.  

2. In the Search programs and files field, type “folder options”.  

3. Select the Change search options for files and folders option. 

4. Open the View tab.  

5. In the Files and Folders | Hidden files and folders section, select Show hidden files, folders, and drives.  

6. Click Apply. 

7. Click OK. 

 


